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Software End User License Agreement 
ATTENTION: THIS SOFTWARE IS SUBJECT TO THE LICENSE TERMS DESCRIBED BELOW. USE OF THIS SOFTWARE 
INDICATES ACCEPTANCE OF THE LICENSE TERMS. IF YOU DO NOT ACCEPT THESE LICENSE TERMS, YOU MAY RETURN 
THE SOFTWARE FOR A FULL REFUND. IF THE SOFTWARE IS PACKAGED WITH ANOTHER PRODUCT, YOU MAY RETURN 
THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND. 
****************************************************************************************************************************************************** 
© KONINKLIJKE PHILIPS ELECTRONICS N.V. 2002 All rights reserved. Reproduction in whole or in part is prohibited without the 
written consent of the copyright owner. This software has been made available for use by end users only. 
****************************************************************************************************************************************************** 

1. Copyright 
The Licensed Software is a proprietary product of Philips, and is protected by copyright laws. Title, ownership rights and 
intellectual property rights in and to the Licensed Software shall remain with Philips. 

2. Right to use 
Philips hereby grants you the personal, non-exclusive license to use the Licensed Software only on and in conjunction 
with one (1) computer at one time. You may not sell, rent, redistribute, sublicense or lease the Licensed Software, or 
otherwise transfer or assign the right to use it. You may not decompile, disassemble, reverse engineer, or in any way 
modify program code, except where this restriction is expressly prohibited by applicable law. Except for one (1) copy 
which may be made for backup purposes only, you may not copy the Licensed Software. You are not allowed to alter or 
remove any proprietary notices, including copyright notices, in the Licensed Software. 

3. Disclaimer of Warranty 
THE LICENSED SOFTWARE IS PROVIDED AS IS WITHOUT WARRANTY OF ANY KIND. THE ENTIRE RISK OF 
USE OF THE LICENSED SOFTWARE REMAINS WITH YOU. TO THE MAXIMUM EXTENT PERMITTED BY LAW, 
PHILIPS MAKES NO FURTHER REPRESENTATIONS OR WARRANTIES EXPRESSLY OR IMPLIED SUCH AS BY 
WAY OF EXAMPLE BUT NOT OF LIMITATION REGARDING MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE, OR THAT LICENSED SOFTWARE IS ERROR FREE, OR THAT THE USE OF THE 
LICENSED SOFTWARE OR ANY COPIES THEREOF WILL NOT INFRINGE ANY PATENT, COPYRIGHT, 
TRADEMARK OR OTHER RIGHT OF THIRD PARTIES. 

4. Updated 
This license does not grant you the right to any upgrades or updates of the Licensed Software. However, Philips will be 
entitled to offer updates and/or modifications to the Licensed Software at its discretion. 

5. Changes of the agreement 
No changes of this Agreement are valid unless with Philips' and your written approval. Any terms and conditions provided 
by you are inapplicable, whether or not contained in order forms or otherwise, unless specifically accepted by Philips in 
writing by means of a duly signed addition to this Agreement. 

6. Limitations of liability 
PHILIPS ACCEPTS NO LIABILITY FOR ANY DAMAGES, INCLUDING ANY LOSS OF PROFIT, LOSS SAVINGS, 
LOSS OF DATA, BUSINESS INTERRUPTIONS, OR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, 
SPECIAL OR PUNITIVE DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE LICENSED 
SOFTWARE, EVEN IF PHILIPS OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. SINCE SOME JURISDICTIONS DO NOT 
ALLOW THIS LIMITATION OF LIABILITY, THIS LIMITATION OF LIABILITY MAY NOT APPLY TO YOU. 

7. Validity and Termination 
The license granted hereunder shall terminate automatically and without notice if you do not comply with all the terms and 
conditions of this End User License Agreement. In the event of termination, you shall immediately stop any use of the 
Licensed Software and destroy all copies thereof. In addition, in the event of termination because of your failure to comply 
with your obligations, Philips reserves the right to invoke any and all other remedies available to it in law or contract 
including the right to claim damages. 

8. Applicable Law 
This contract shall exclusively be governed by the laws of the Kingdom of The Netherlands without regard to its conflict of 
law provisions. 

9. Competent Court 
The competent court for any dispute between you and Philips pursuant to this End User License Agreement is the court 
of 's-Hertogenbosch, the Netherlands. 

© Philips Consumer Electronics B.V., 1999-2002, Eindhoven, The Netherlands 
V-1 991214
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INTRODUCTION 
Congratulations on your purchase of the Philips Seismic Edge Sound Card! 
 
Thank you for enhancing your computer with the Philips Seismic Edge™.  We know you’ll agree, once you 
give it the edge, that your PC will never sound the same again. 
 
Now get ready to ignite your imagination with the most immersive soundstage ever created on a PC . . .  
 
… a full-blown, digital surround-sound, discrete six-channel home theater experience, through your new 
Philips Seismic Edge Sound Card.  Seismic Edge is the first PC card to deliver the impact of 6 distinct 
channels of sound, using advanced digital signal processing algorithms and extreme hardware acceleration, 
extracting audiophile-quality sound from your PC with no added strain to your processor – not just from 
DVD’s or 3D audio games but from all your games, music and movies. 
 
Load your favorite music, games and movies and be prepared to hear every detail as never before 
articulated through 96 distinct 3D voices, 256 distinct DirectSound voices and 576 distinct synthesized 
Wavetable voices. 
 
The heart of your sound card is Philips’ powerful new ThunderBird Avenger audio processor, which relieves 
your computer of performing enormously complex audio processing.  The results are dramatically faster, 
more-responsive gaming effects and more-convincing three-dimensional audio soundfields, all without 
placing new demands on your computer. 
 
Advanced DSP algorithms from QSound Labs provide rich three-dimensional sound for every application.  
If you have headphones or only two speakers, Seismic Edge’s patented psycho-seismic codes envelop you 
in a virtual soundfield created from up to ninety-six independent 3D voices. 
 
Add rear, center and subwoofer speakers, and Seismic Edge will transform your PC into your personal 
home theatre system, fully capable of playing the very latest Hollywood DVD releases in full-blown digital 
glory.  Take your music CDs, MP3s, video files, cut scenes and stereo games to the max while you’re at it – 
rediscover your existing collection while you add new favorites too! 
 
Seismic Edge truly revolutionizes PC sound.  Install your sound card as directed, connect a 5.1 speaker 
system (left & right front, left & right rear, center, and subwoofer) and try these: 
 

• Play the latest Hollywood DVD hit and be prepared for goosebumps as sound effects sweep you 
away. 

• Rediscover your favorite music in a whole new dimension – even those golden oldies.  You’ve 
never heard them like this before! 

• Play a 3D audio-enabled game and experience what “virtual reality” can mean. 
• Elevate your classic 2D games to a whole new level of audio realism. 
• Compare enhanced QMSS to ordinary Dolby Digital on DVD and hear the remarkable differences. 
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Key Features 

• 256 streams of DirectSound acceleration and digital mixing 
• 96 streams of 3D audio acceleration including positional reverb, obstruction and occlusion 
• Full-duplex, 48khz digital recording and playback 
• Philips ThunderBird Avenger™ high performance audio accelerator 
• Hardware DSP accelerated QSound 3D algorithms including 

o QSound3DInteractive™ positional 3D 
o QSound Environmental Modeling for EAX™ and DS3D™ games 
o QSound Multi Speaker System™ for quad or 5.1 output of stereo sources 
o QXpander™ for 3D enhancement of stereo 
o DVD QSurround™ 5.1 speaker virtualization over stereo speakers (compatible SoftDVD 

player required) 
• 576 voice total wavetable synthesis music polyphony 

o 512 Voice professional quality soft-synth with GM compatibility 
o 64 channel hardware wavetable synthesizer 

• Dual gameport accelerator with legacy and digital joy-stick modes 
• DirectSound™, DirectSound3D™, EAX™ 1.0 , EAX™2.0/I3D Level 2, and A3D™  1.0 compatibility 
• Stereo , 4 channel surround , 5.1 speaker or headphone output 
• QMSS™ enhanced DVD playback mode (compatible SoftDVD player required) 

 

Minimum System Requirements 
Installation of your Philips Seismic Edge requires the following hardware and operating system: 
 

• One available PCI 2.1 compliant slot 
• Intel Pentium® class or 100% compatible 166Mhz or faster processor 
• Intel® or 100% compatible motherboard chip set 
• 16MB system RAM 
• CD ROM for driver installation 
• Stereo, 4 channel surround powered speakers, 5.1 speakers or headphones 
• Windows® 95, Windows® 98, Windows NT® 4.0 (SP3)*, Windows® 2000, Windows XP** 
 

*Not all product features supported using this operating system. 
** Windows XP minimum system requirements are different and should be observed for proper Windows 

operation. 
 

What’s Included   
You will find the following items in your Seismic Edge™ package: 
 
1-Seismic Edge™ sound card in a anti-static pouch 
1-Seismic Edge™ installation CD 
1-Analog audio cable to connect CD/DVD drive to sound card 
1-Seismic Edge™ user’s manual included in the installation CD 
1-Product registration card 
Bundled applications may be included on the installation CD or on separate media depending on the 
Seismic Edge™ model 
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INSTALLING SEISMIC EDGE 
What you need for installation 
Computers come in different shapes and sizes. The installation procedures in this manual apply generally 
and you should compare the illustrations here with your computer before you start your sound card 
installation. 
 
• Sound card 
 
• Installation CD 
 
• CD Analog Audio Cable 
 
• A Phillips screwdriver 
 
• Have your Windows® installation CD available as it may be needed to complete installation of common 

software components. 
 

Video Guide 
A 3-part video installation guide can be found on the Seismic Edge Installation CD.  

If CD/DVD autorun is enabled, a Philips Edge series Autorun window will pop up when the CD is inserted 
into the CD drive. Then click on the “View PSC703/705 Installation Videos” icon from the window. Another 
Philips Edge Series Autorun window will pop up; click on the either Part 1: Introduction.mpg, Part 2: 
Hardware.mpg, Part 3: Software.mpg depending on which part you want to view. 

If CD/DVD autorun is disabled, double click on “autorun.exe”, located in the root directory of the Philips 
install CD, or run it from the Windows Start/Run menu. Another way to manually start is by double clicking 
on Desktop/My Computer, then click on the Philips Edge icon. Once the Philips Edge Series Autorun 
Window pops up you ma make the same choices as stated above. (Part 1: Introduction.mpg, Part 2: 
Hardware.mpg, Part 3: Software.mpg). 
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Important Notice 
 

 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Uninstall the drivers for any previously installed sound cards.  Consult your previous 
sound card documentation for details. 
Turn off computer and remove existing sound card. If your computer has on-board 
sound, consult your PC documentation to disable it. 

!!!! 
STATIC ELECTRICITY CAN CAUSE PERMANENT DAMAGE 

TO YOUR SOUND CARD. 
 

To prevent damage please: 
 
1. Always hold your sound card by its edges.  Avoid touching 

any electronic components on your sound card. 
 
 
2. Use a grounding strap or touch any non-painted surface of 

your computer chassis before you begin installation to 
discharge static electricity. 
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Hardware Installation 
Turn off your computer, and disconnect the power cable. 
Disconnect all devices that are connected to the computer. 
Remove the computer cover. 
 

 
 
 
 
Select an available PCI slot and, if necessary, remove its cover plate.  Keep the mounting screw to secure 
your sound card later.  Save the mounting plate for possible use later.   
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Remove the Seismic Edge Sound Card from the anti-static bag.  Align your sound card with the selected 
PCI Bus-Slot and firmly push it into the slot.  Be sure the sound card is aligned properly and fits snugly into 
the slot. 
 

 
 
 
 
 
Use the screw from the slot cover to secure the sound card to the frame of the computer chassis, but do not 
over-tighten.  Securing the card assures proper grounding.   
 

 
 

 
                        
 
 

Align sound card and fit firmly into 
place
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Sound Card Configuration 
Please note that actual card layout may vary 
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Connecting to Your Seismic Edge Sound Card 
Speakers 
Your Seismic Edge card can be configured as either a 5.1 channel analog output or 4 channel analog output 
and S/PDIF Output depending on the Output Mode selected within the Settings Tab (see Settings Tab 
section in this manual). When 5.1speaker mode is selected (default), the S/PDIF Out is disabled (grayed out 
on the control panel). 
 
Headphone, 2 Speaker and 4 Speaker Connections 
Connect your front speakers or headphones into the FRONT OUT stereo jack on the end bracket. Connect 
your rear/surround speakers to the REAR OUT stereo jack on the end bracket. 

 
5.1 Speaker Mode 
Connect your center/LFE speakers into the Cen/LFE or S/PDIF Out stereo jack on the end bracket. 

 
S/PDIF Out Mode (Headphone, 2 or 4 speaker mode only) 
To utilize the S/PDIF Out (Sony Philips Digital Interface Format) feature of your Seismic Edge card, insert a 
1/8” stereo or mono plug to dual or single RCA plug adapter cable (not included) into the Cen/LFE or 
S/PDIF Out stereo jack on the end bracket. The S/PDIF Output can be connected to digital speakers, an 
AC-3 or DTS decoder, receiver or other device with an S/PDIF input. Note: If using a stereo cable, S/PDIF 
Out will come from the left jack. 
 
S/PDIF 
To connect digital speakers, an AC3 or DTS decoder, receiver or other device with an S/PDIF Out of the 
sound card plug it into the S/PDIF jack on the end bracket 
 
Line In, Mic In and MIDI/Joystick 
External analog stereo sources with line level output can be connected to light blue 3.5mm stereo jack at 
the top of the sound card bracket.  A microphone can be connected to the pink 3.5mm mono jack.  An 
analog or digital joystick and/or MIDI devices can be connected to the large connector at the bottom of the 
bracket. 
 
Internal Connections 
Connectors for three line level analog inputs (Aux In, TAD, Analog CD In) are provided along the top of the 
sound card as indicated in the picture on page 11. Use the 4 pin CD audio cable to connect the analog 
audio output of you internal CD or DVD drive to the sound card “Analog CD In” connector. 
Replace computer cover and reconnect the power cable, monitor, and other 
devices. 
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SOFTWARE INSTALLATION 
Windows® 95/98/2000/XP Installation 
Now that the hardware is installed, it is time to install the drivers. Plug and Play uses your system’s BIOS to 
allocate resources for Philips Seismic Edge. 
 
 
WHICH VERSION OF WINDOWS DO YOU HAVE? 
Microsoft issued a maintenance release of Windows® 95 referred to as OSR2.  This version shipped as the 
stock operating system on many PC’s.  Newer and recently upgraded PC’s will have the Windows® 98 
operating system.  Other systems will have the original Windows® 95 or “Gold” version.  The following 
procedure describes installation using Windows® 98/98SE.  Windows® 2000 and Windows XP screens are 
slightly different but the procedure is the same as described.  If you have older versions of Windows® 95 
then the installation will be slightly different than described below. 
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To Install The Drivers For Windows® 95/98/2000/XP: 
1.  Turn on the computer and place the Philips Seismic Edge CD in your CD-ROM drive.    

 
When the Add New Hardware Wizard dialog box reports that a new PCI Multimedia Audio Device 
has been detected, click NEXT.     

 
 

 
 
 

2. Select Search for the best driver for your device (Recommended).  Click NEXT. 
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3.  If you are installing from the install CD or if you have copied the install to any other location, select 
Specify a location and browse to your directory where the setup files are located.  For Windows® 
95/98, select Win9x directory then choose a language.  For Windows® 2000/XP, select WDM 
directory.  Click NEXT. 

 
 

 
 

 
4.  Select NEXT to install the drivers. 
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5.  Windows® then copies the files.  You may be prompted to insert your Windows® CD or floppy, as the 
core sound components of the operating system may need to be copied as well.  These include audio 
Codecs, the Mixer and the Sound Recorder program.   

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
6.  The installation will continue to install the files to your system.  For Windows® 95/98, Click FINISH. 
 
For Windows® 2000/XP, you must install the Philips Seismic Edge Audio and Philips Seismic Edge 
GamePort Enumerator devices.  Browse to the Driver disk directory WDM\English to install these files.  
You will find these files in the same WDM install directory and Windows® will finish installing the drivers 
for Philips Seismic Edge automatically.  Click FINISH 2 times on each screen to install each of these 
devices.  
 

 
 

7.  After clicking “Finish” the Philips Seismic Edge GamePort will be installed.  It is possible during 
gameport installation, Windows® will detect newer versions of  msanalog.vxd, vjoyd.vxd and 
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msjstick.drv.  It is recommended that you keep your existing files.  Click YES on all 3 screens that 
appear.  

 
 

 
 
 
 

8. Next, the software launcher will allow you to open the Seismic Edge control panel and configure your 
speaker settings if desired.  Select YES to modify these settings now, or select NO to modify later.  
Speaker settings are described under the Analog Output Tab in this manual.  

 

 
 

Note:  Any time you say No to a Applications Launcher dialog box like the one shown above, a 
second box will appear asking if you want launch the next time Windows is started.  Answer Yes or 
No as desired. 
 

 
9. Next, the DirectX® Setup dialog box will appear.  Click OK. 
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17.   Next, the software launcher allows you to install Sonic Foundry SIREN Jukebox XPress.  This 

application allows you to play and organize music.  Click YES on the dialog box and follow the 
installation screens to install this software.   See section About SIREN Jukebox Express to learn 
more about this application.  

 
18.   Product Registration – If you are connected to the Internet, you can register your product now by 

clicking YES in the dialog window shown below.  If you prefer to register your product at a later 
time, go to: www.philipsusa.com/prod_reg_bounce.html and follow the instructions. 

                
 

 
 
 
 
CONGRATULATIONS! You have successfully installed your Philips Seismic 
Edge™.   
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Windows NT® Installation 
Installation of the drivers for your Philips Seismic Edge™ in a Windows NT® environment 
are as follows (note: you must have the appropriate privileges in order to install the drivers): 
 
1) Boot the system to the Windows NT® desktop and insert your installation CD in your CD-ROM drive. 
2)  
3) Go to D:\NT40\English and double click on Philips Seismic Edge Install.exe. (D: represents your CD-ROM 

drive). 
4)  
5) Wait a couple of minutes while the data transfers. Once it finishes the Philips Seismic Edge Settings 

window will appear. Click OK on the settings page and then when the “System Settings Change” page 
comes up and prompts you to restart, click the “Restart Computer Now” button. 

 
That’s it! Once the system reboots to Windows NT® your Philips Seismic EdgeTM should be 
fully functional as will be indicated by the Windows® Startup sound. 
 

Siren XPress Installation for Windows NT® 
Follow these steps to install the Siren XPress.  This application allows you to play and organize music. 
 
1) Insert your install CD into your CD drive 
2) Go to D:\Applicatoins\Sonic Foundry\Siren\ (D: represents your CD-ROM drive) 
3) Double Click on Sirensetup.exe 
4) Follow the on-screen instructions for installation 
 

REAL MODE DOS INSTALLATION (OPTIONAL)  
This step is only required if you intend to run DOS applications under real 
DOS mode by restarting your computer in “MS-DOS mode”.  This step is not required to run DOS applications 
in a DOS box (MS-DOS prompt). 
 
In real DOS mode, you must have your DOS CD-ROM drivers loaded for 
access to the install CD.  Another way to do this is to simply run INST_DOS.BAT from a DOS box in Windows. 
 
Run INSTALL.EXE from the DOS directory on the CD.  This installation 
program will create the TBird directory on any drive you desire. Follow the screen prompts to install the files to 
your hard drive.  The install program will edit your autoexec.bat file to perform automatic initialization of Philips 
Seismic Edge for use in real mode DOS . 
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Using the Philips Seismic Edge Control Panel for DOS 
To launch the DOS control panel: 
 
1. Go to C:\Seismic\ (C represents you hard drive) 
2. Type VOLCNTRL.EXE 
 
This application allows you to adjust volume levels, balance, input levels, synthesizer modes, speaker modes, 
and midi effects in real DOS.  
 
In DOS games that have music settings, if you select FM synthesis in the game, make sure the synth control in 
the control panel is set to OPL3.  For games that support MIDI (mpu-401), select the WVTBL (wavetable) 
option. The game publisher normally has this information in the program documentation. 
 
NOTE:  This application is for real MS-DOS mode only and should not be run under windows.  In Windows®, 
use the Windows® mixer for adjusting playback and recording levels. 
 
Joystick Configuration for Windows® 95/98/2000/XP: 
1. Open the Control Panel and double-click on the Game Controllers icon.  Select the Advanced tab and 

under Port Driver Assignment and select Philips Seismic Edge GamePort. 
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2.  Select the General tab and click the Add button.  You may select any one of  the Game Controllers listed, 
then click OK. 

 
  

 

 
                              
 
3.  After making your selection, highlight the selected controller in Game Controllers and click the Properties 

button.  Select Calibrate and calibrate your joystick.  Your joystick should be installed and ready for flight! 
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TECHNICAL SUPPORT 
Before calling the technical support number please make sure you have the following information available: 
 
• Model and serial number and date of purchase. 
• Computer type, processor speed, and memory available. 
• Computer Operating System (IE: Windows® 95, Windows® 98, etc.) 
• On-screen error information. 
• Other hardware connected to your sound card.  
 
Technical Support Information: 
 
• Toll-Free Telephone Number: 1-800-835-3506 
 
• Operating Hours (US Central Time): 

• Monday through Friday   7:00am – 11:00pm 
• Saturday & Sunday  8:00am – 10:00pm 

 
• Internet Address:  www.philipsusa.com  
 
Product Return 
Before returning the Philips sound card, you must first contact the Philips Technical Support group to determine 
the nature of product defect.  Once the nature of the problem has been determined, a Return Authorization 
number and address will be supplied.  A RETURN AUTHORIZATION NUMBER MUST ACCOMPANY THE 
RETURN OF THIS PRODUCT. 
 
When returning the product for service: 
• The cost of shipment is at your expense and you assume all the risk.  It is recommended to ship the 

product through a carrier that provides proof of delivery and product should be insured. 
• Return Authorization number must be clearly marked on the outside of the package. 
• Use proper packing materials for shipment 
• A dated proof of purchase proving the product is still under Warranty 
 
Warranty:  3-year limited warranty 
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SEISMIC EDGE DSP SPECIAL EFFECTS AND ALGORITHMS 
 
EAX™ Game Compatibility (Effects Tab) 
The Seismic Edge uses QSound Environmental Modeling™ (QEM™) to achieve compatibility with games 
utilizing EAX™ 1.0 or EAX™ 2.0 properties including environmental reverb, obstruction and occlusion 
modeling.  EAX™ is a trademark of Creative Labs. 
 
DVD QSurround™ (Settings Tab) 
Provides virtual 5.1 playback using just stereo speakers and a compatible soft-DVD player capable of providing 
5.1 output. 
 
QSound Environmental Modeling™ /QEM™ (Effects Tab) 
QSound Environmental Modeling (QEM) provides EAX game compatibility and the ability to apply reverb to 
non-EAX sound sources including applications, S/PDIF In and external inputs. 
 
QSound Multi-Speaker System™ /QMSS™ (Settings and S/PDIF Tabs) 
QMSS (QSound Multi-Speaker System) transforms stereo sources into 4 channel or 5.1 channel output.  
QMSS is automatically invoked for stereo applications if 4 speaker or 5.1 speaker mode is selected.  QMSS will 
also be applied to analog inputs (CD In, Line In, etc.) and the S/PDIF In if enabled on the control panel. 
 
QSound3DInteractive™/Q3DI™ (Automatic) 
Q3DI positions sounds all around you using stereo, surround, 5.1 speakers systems or headphones when 
playing 3D audio enabled applications. The proper DSP algorithm is automatically selecting based on your 
speaker mode. 
 
QXpander (Settings Tab) 
QXpander widens the sound field of stereo music and provides 3D enhancement to 2D audio games when 
using stereo speakers. 
 
Tone Control (Settings Tab) 
Allow you to adjust treble and base levels to your personal taste. 
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SEISMIC EDGE CONTROL PANEL 
Help Button 
Click the yellow “Help” button on any tab and you will have access to comprehensive hyper linked help file 
describing the control panel.  Within the help file you can navigate by simply clicking on parts of the image of 
the control panel, or by using index lists. 
 

Utilities Tab 
Windows® Audio Applications 
 

 
 

 

Volume Control:   
Windows® audio mixer for adjusting volume of various sound sources.  
 

Multimedia Properties:   
Windows® utility for selecting multimedia devices.  Use it to switch between the Seismic Edge’s two MIDI 
music synthesis engines.  (See “MIDI Tab” section)  
 

Sound Recorder, Media Player & CD Player:   
Windows® playback and record applications. 
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Space Junk & Wumpus:   
3D audio applications that demonstrate QSound Lab’s 3D audio technology.  You must have the Seismic Edge 
install CD in your CD-ROM drive to launch these applications. 
 

Show Control Panel Icon in the TaskBar:    
Enabling this allows you to open the control panel from the taskbar.  Default setting is enabled. 
 
 
 
 



 
 
 

 27

Settings Tab 
This tab allows you to select your exact speaker configuration and provides you with sliders for adjusting the 
master volume, left/right speaker balance, fade control (balance between front and back speakers), Center/LFE 
(Low Frequency Effects) level control for 5.1 channel playback, and Tone Control which affects all channels. 
 
 

 
 
 

Output Mode 

Headphone 
Select this mode when listening using headphones rather than speakers.  The headphones should be plugged 
into the “front” speaker jack. 
 
Selecting “Headphone” tells the sound card to use a special 3D algorithm when playing 3D games.  Selecting “2 
Speakers” will result in incorrect sound positioning when using headphones.  Selecting “Headphones” when 
using speakers will reduce the effectiveness of 3D effects. 
 
Note:  The Seismic Edge is designed for use with headphones or amplified (powered) speakers.  Use with 
passive (non-amplified) speakers is not recommended. 
 
2 Speakers 
Select this mode when using stereo (2 or 3 piece) speaker systems.   The Seismic Edge will apply advanced 
3D algorithms to virtualize sounds all around you when playing compatible 3D audio enabled games. 
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QXpander 
QXpander widens the sound field of stereo music and provides 3D enhancement to 2D audio games.  Using 
this feature in combination with speakers providing “3D enhancement” may cause distortion and is not 
recommended. 

 
DVD QSurround 
This feature will greatly enhance your listening experience when used during DVD playback in 2 speaker mode.  
This feature will provide the sensation of a full-blown 5.1 speaker system by virtualizing the surround speakers. 
For proper operation 5.1 output must be selected in the soft-DVD player’s control panel. 
 
QSurround requires a soft-DVD player capable of providing 5.1 channel output.   
If your soft-DVD player does not offer 5.1 output mode then select “stereo’ or “Pro-Logic mode” in the soft-DVD 
player’s control panel and select QXpander mode instead of DVD QSurround. 

 
The Seismic Edge supports numerous playback modes for various speaker configurations.  See the “DVD 
Playback Modes” section of this manual for details. 
 
4 Speakers 
Select this if you have a 4 or 5 piece speaker system (stereo front left and right and rear/surround left and right 
speakers and optional subwoofer).   3D sounds generated by compatible applications will processed to the 
appropriate speaker and stereo sounds from applications will be expanded to four distinct channels using 
QMSS.  
 
Stereo sources from external inputs (CD In, Line In . . .) will not be expanded to the rear speakers unless the 
source is selected in the “Apply Reverb/QXpander/QMSS to External Input Source:”.  Similarly the “Apply 
QXpander/QMSS” box must be checked under “S/PDIF In” on the “S/PDIF” tab in order for S/PDIF In sources 
to be expanded to all 4 speakers. 
 
If your front or rear speakers are digital (S/PDIF) rather than analog then see the “S/PDIF” section of this 
manual for additional instructions. 
 
5.1 Speakers: 
Select this mode if you have a 5.1 speaker system (front left, front center, front right, surround left and right 
speakers and LFE/subwoofer).  3D sounds generated by compatible applications will processed to the 
appropriate speaker and stereo sounds from applications will be expanded to 5.1 distinct channels using 
QMSS.  
 
Stereo sources from external inputs (CD In, Line In . . .) will not be expanded to the rear, center and LFE 
speakers unless the source is selected in the “Apply Reverb/QXpander/QMSS to External Input Source:”.  
Similarly the “Apply QXpander/QMSS” box must be checked under “S/PDIF In” on the “S/PDIF” tab in order for 
S/PDIF In sources to be expanded to all speakers. 
 
If your front or rear speakers are digital (S/PDIF) rather than analog then see the instructions in the “S/PDIF” 
section of this manual. 
 
Be certain your Ce/LFE speakers are connected correctly when using this mode. (See 
Connecting to your Seismic Edge Sound Card Section). 
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DVD SSM (Small Speaker Mode) 
Check this box if you will be utilizing Dolby Digital DVD playback mode using small satellite speakers. This will 
enable the subwoofer connected to the sound cards’ LFE output to produce the bass content that the satellites 
cannot produce.  This box will have no effect when using QMSS DVD Enhancement. (See DVD Playback 
Modes). 
 

Expand All 
This feature only works with Windows 2000 and Windows XP/WDM drivers.  

Select “Expand All” before starting the application to transform stereo applications to 4 or 5.1 speaker playback. 
This occurs automatically in other operating systems. 

 

Output Control 

Balance Slider 
Use this slider to adjust the relative volume of the right vs. left speaker.  The overall volume will not be 
affected. To center the balance slider automatically, right click on the balance slider, and choose “Center”. 
 

Fade Slider 
Use the slider to adjust the relative volume of the front vs. rear speaker.  To center the fade slider 
automatically, right click on the fade slider, and choose “Center”. 
 

Volume Sliders 
 

Center: To adjust the volume output for the center channel in 5.1-Speaker mode. 
 
Master: To adjust the volume output for the master volume (all speakers affected). 
 
LFE: To adjust the volume output for the Low Frequency Effects channel in 5.1-Speaker mode. 
 
Tone Control 
Treble and/or Bass level can by emphasized by checking the “Enable” box and adjusting the Treble and/or 
Bass sliders.  Uncheck the “Enable” box or adjust the sliders to the bottom for a flat response. 
 
Default Button 
The default button will disable tone control and set Tone Control sliders to minimum (flat).  All other sliders 
under “Output Control” are centered. 
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S/PDIF Tab   
This page of the Philips Seismic Edge Control Panel will control the settings for the Digital Audio input and 
output.  S/PDIF is the acronym for industry-wide standard called Sony/Philips Digital Interface.  This tab is 
linked to the settings tab. If you selected 5.1 speakers under the settings tab, S/PDIF Out is disabled and will be 
grayed out. Selecting Headphone, 2 or 4 speaker mode will allow you to select a desired S/PDIF Output. 
 
 

 
 
 
S/PDIF OUT  (NOT FUNCTIONAL IN 5.1 SPEAKER MODE)
 

Disabled 
In this mode S/PDIF Out is disabled.  Select one of the following options to determine what content will be sent 
to the S/PDIF Out connector. 

 

Front Left and Right Channels 
In this mode the same content being sent to the front Line Out speaker jack in analog format will also be sent to 
the S/PDIF output in digital format for applications running on your PC (MP3, games, etc.).  For external inputs 
(CD-In or Line In), select the proper source on the “Apply Reverb/QXpander/QMSS to External Input Source” 
pull down menu located on the Settings tab.  Use this mode if you are using digital S/PDIF speakers for your 
front speakers or wish to send the front speaker stereo signal to an external device connected to the S/PDIF 
output such as a mini-disk recorder or receiver with S/PDIF In. Please note that the volume settings on the 
Settings tab will have no affect on the signal on the S/PDIF output.   
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Rear Left and Right Channels 
In this mode the same content being sent to the rear/surround Line Out speaker jack in analog format will also 
be sent to the S/PDIF in digital format for applications running on your PC (MP3, games, etc.).  For external 
inputs (CD-In or Line In), select the proper source on the “Apply Reverb/QXpander/QMSS to External Input 
Source” pull down menu located on the Settings tab. Use this mode if you are using digital S/PDIF speakers for 
your rear speakers.  For proper operation you must also be in 4 speaker mode. Please note that the volume 
settings on the Settings tab will have no affect on the signal on the S/PDIF output. 
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DVD AC3/DTS 
Use this mode if you wish to play DVD audio using an external AC3 or DTS decoder such as a speaker set, 
receiver or decoder box connected to S/PDIF Out.  This mode is only available when using a compatible soft-
DVD player capable of streaming AC3 or DTS data to the sound card 
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Effects Tab  

Reverb/QXpander/QMSS to External Input Source 
Reverb, QXpander (when enabled), and expansion of stereo to 4 or 5.1 channels (QMSS) are automatically 
applied to all sounds generated by applications running on your PC however they are not applied to inputs such 
as analog “CD In” and “Line In” unless that input is selected on the “Apply Reverb/QMSS/QXpander to External 
Input Source “ selector pull-down menu. 
 
For example if you are using the Microsoft “CD player” which uses the analog “CD In” connector to play CD’s or 
if you are using a tape deck or other external device connected to “Line In” you must select the input here to 
enable conversion these stereo sources to 4 or 5.1 channels using QMSS.  However if you are using an 
application that is not dependent on these connections such as a game, MP3 player, or a CD player that uses 
digital extraction rather than analog “CD In” (such as the included Siren JukeBox application) then QMSS is 
used to automatically convert these sources to 4 or 5.1 channels (when in 4 or 5.1 speaker mode). 
 
These controls allow you to manage the application of reverb and QSound Environmental Modeling™ 
(QEM™).  QEM provides EAX 1.0/2.0 game compatibility and the ability to apply reverb to non-EAX sources 
including applications, and external inputs. 
 
 

 
 
Enable 
When playing games supporting EAX properties select the “Enable” box under “Reverb/QSound Environmental 
Modeling”.  Set the Environment selector to “- none –“ to avoid reverb being applied to non-EAX applications. 

 
To apply reverb to non-EAX applications also select a reverb type using the “Environment” selector described 
below and adjust the reverb level using slider corresponding to the source. 
 



 
 

 34

Environment 
Using this pull down menu you can select various types of reverbs that simulate various environments.  To turn 
on these environments the “Enable” box must be selected. 

 
If you are playing an EAX 1.0 or 2.0 game it should automatically select the appropriate environment as you 
move around the game.  The environment selector can be left on “-none-“. 

 
If you are playing a non-EAX enabled game, music or movies you can select an environment of your choice 
and adjust the level using slider corresponding to the source. 

 
If you are using the Philips Seismic Edge (H/W) Synth, the “Environment” you select will also be used when 
playing MIDI music and the intensity will be controlled on the reverb slider on the MIDI tab. 
 
Some “Environments” such as “Concert Hall” are more appropriate for music while others like “Forsaken” were 
designed with specific games in mind and others like “Drugged” are for gaming and general playing around.  

 
  
Reverb Level Sliders   
Audio Applications slider:  Control the intensity of the effect for games, Sonic Foundry Siren Wavetable 
synth (also has its own reverb effect controls) and other applications. 

External Input slider:  Control the intensity of the effect for analog input sources such as CD In and Line In. 

These sliders, used in conjunction with the “Enable” box and the “Environment” pull down menu, allow you to 
control the intensity and characteristics of the reverb effect applied to your sound. Reverb is an seismic effect 
that simulates the interaction of sound with the environment.  As an example imagine the sound of a gunshot in 
a large cathedral compare to the same sound in a tiled bathroom.  The entry under “Default Environment” 
allows you to select a certain surrounding (environment) such as a cave, arena or hallway) while the sliders 
provide for control over the intensity of the effect. 

Typically very low settings should be used when using to add ambiance to music or games rather than higher 
settings that may cause distortion and sound unnatural. 
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MIDI Tab 
Your Seismic Edge™ sound card includes a wavetable music synthesis engine. This WaveTable Synth is a 
pure hardware synthesis engine designed for use with games or other applications were low CPU consumption 
is critical.  Select the Seismic Edge WaveTable Synth only for games that utilize MIDI for music.  Note that 
most current PC games do not use MIDI music. These games use digital sound recordings exclusively and are 
not effected by MIDI output selection. 
 
 

 
 
 
 

Default MIDI Device 
When your card is initially installed the Seismic Edge wave table synth is selected as your default MIDI engine.  
To view your default selection look under “Default MIDI Device” on the MIDI tab.  MIDI applications will use this 
default device unless they have been specially configured to use a different device.  If you want to change the 
default wave table synth follow the following procedure: 

 
 

Multimedia Properties 

Use this ICON to change your default MIDI device: 
 

1. Click on the Multimedia properties icon 
2. Select the MIDI tab on the “Multimedia Control Panel” 
3. “Single instrument” will be selected 
4. To change to a different MIDI output select it then select “Apply” or “OK”.  You can select either “ 

“Seismic Edge WaveTable Synth” (games with MIDI) or Seismic Edge External (if you have an 
external synthesizer connected to the Game/MIDI port of the card. 

 
 



 
 

 36

H/W Wavetable Voices 
Use this and the H/W Wavetable Chorus and Reverb Level controls to adjust Seismic Edge WaveTable synth.  
These adjustments will have no effect on MIDI playback unless the Seismic Edge Wavetable synth is selected 
as the MIDI device. 
 

Better Gaming 
To achieve the best sound in gaming use the default setting. Best setting for Windows® DirectSound® and 
DirectSound3D Gaming. Maximum hardware acceleration for games. 
 
 

H/W Wavetable Chorus Level 
None:  Chorus effect is not applied. 

As Specified in MIDI File:  Chorus effect is applied only as specified MIDI file being played.  If no chorus is 
specified for a MIDI voice then no change will be observed when switching between this mode and “None” 
mode. 

Global:  Chorus will be applied to all MIDI voices regardless of the MIDI file and the chorus intensity will be set 
using the slider. 
 

H/W Wavetable Reverb Level 
None:  Reverb effect is not applied. 

As Specified in MIDI File:  Reverb effect is applied only as specified MIDI file being played.  If no reverb is 
specified for a MIDI voice then no change will be observed when switching between this mode and “None” 
mode.  Reverb must also be enabled and a reverb “environment” selected on the “Effects” Tab. 

Global: Reverb will be applied to all MIDI voices regardless of the MIDI file and the reverb intensity will be set 
using the slider.  Reverb must also be enabled and a reverb “environment” selected on the “Effects” Tab 
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Speaker Test Tab 
 

 
 
 
The speaker test tab is a utility to help verify proper speaker connections to your sound card.  The acronyms 
are defined as follows: 
 
LF – Left Front Speaker 
CTR – Center Speaker 
RF – Right Front Speaker 
RS – Right Surround Speaker 
LFE – Low Frequency Effects / Subwoofer 
LS – Left Surround Speaker 
 
Select the Output Mode you wish to test. 
 
There are two modes to test your speaker settings: Manual and Auto 
 
Manual Mode: 
 
Once you have selected the appropriate Output Mode, click on any of the desired speakers to verify proper 
connection.  You can check the Loop Sounds box that will result in continuous sound in that speaker.   Click the 
Stop button to stop the test.   
 
Auto Mode: 
 
Clicking on Auto Mode.  Sounds will emanate in sequence starting with LF and cycle through each speaker in 
the Output Mode you selected.  The Stop Button and Loop Sounds options do not apply to Auto Mode. 
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Use the Master Volume Slider to adjust the overall output level of your speaker system. 
 
Adjust speaker connections as required to complete your sound card installation.   
 

Information Tab 
 

 
 
 
The information tab provides detailed information about your sound card.  This includes the model number for 
your product and software version information.   
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DVD PLAYBACK MODES  
Using 4 or 5.1 channel surround speakers your Seismic Edge™ sound card can deliver true multi-channel 
surround sound from a compatible soft-DVD player application even if the player only supports stereo output.  If 
the soft-DVD player is capable of providing a true 5.1 Dolby Digital or a 4 channel Dolby Digital™ down-mix 
Seismic Edge will output all 4 or 5.1 Dolby Digital channels.   Even if the soft-DVD player supports 4 or 5.1 
channel Dolby Digital™ you may prefer using QMSS™ playback of DVD’s because of the enhanced rear 
channel content it provides.  If you have only stereo speakers Seismic Edge can also provide virtual surround 
using its QSurround feature. 
 
To enable 4 or 5.1 speaker QMSS™ DVD enhancement: 
 

1) Make sure “4 Speakers” or “5.1 Speakers” is selected in the Seismic Edge control panel settings tab. 
2) Open the “control panel” or “settings” menu for the soft-DVD player. 
3) Select the menu or tab that controls the player’s audio settings. 
4) Look for a panel that allows you to select the number and type audio channels 
5) Select either 2 speaker “Stereo” or 2 speaker “Dolby Surround or ProLogic”.  Either option will work well 

as the QMSS™ DSP algorithm does not depend on Dolby encoding.  (Effectively you should follow the 
soft-DVD player instructions for playing back over stereo speakers even though you have a quad or 
5.1speaker system connected). 

6) Close the control panel and play a DVD.  Seismic Edge will detect that it is in 4 or 5.1 speaker mode 
but is only receiving two channels of audio from the DVD and automatically generate 4 or 5.1 distinct 
channels of surround sound using QMSS™. 

 
To enable a 4 or 5.1 speaker Dolby Digital™ playback : 
 

1) Make sure “4 Speakers” or “5.1 Speakers” is selected in the Seismic Edge control panel settings tab. 
2) Follow the soft-DVD players instructions for 4 or 5.1 speaker playback.  (Some players will not offer this 

feature) 
3) Play a DVD and Seismic edge will output the 4 or 5.1channel Dolby Digital sound provided by the soft-

DVD player. 
Seismic Edge supports Microsoft’s standards for multichannel playback however some soft-DVD players 
may not.  If this mode does not work with your soft-DVD player then use QMSS DVD enhancement mode 
described in the preceding section. 

 
If you only have stereo speakers: 
 

1) Make sure “2 speakers” is selected in the Seismic Edge control panel settings tab. 
2) Select “DVD QSurround” under “2 speakers” in the Seismic Edge control panel. 
3) Follow the soft-DVD players instructions for “5.1 speaker” playback.  [If your soft-DVD player does not 

provide a 5.1 speaker mode then select “QXpander” instead of “DVD QSurround in line 2) above follow 
the soft-DVD players instructions for “stereo” playback instead] 

4) Play a DVD and Seismic Edge will virtualize surround effects coming from the DVD. 
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SIREN XPRESS 
Transform your PC into the ultimate music entertainment center with SIREN XPress music jukebox. SIREN 
XPress lets you "rip" your CD collection onto one convenient location—your hard drive. Let SIREN XPress help 
you surf the net and find more great music to add to your collection—MP3, WAV, and WMA files are all 
supported. Use SIREN XPress' advanced organizational features to create custom playlists of the songs you 
want to hear. SIREN XPress maximizes your audio experience with dazzling, colorful eye candy—real-time 
computer animation that pulses and interacts with your songs. And when you're ready to hit the road with your 
portable MP3 player,* SIREN XPress is the fun, easy way to upload your custom playlists.  
 
* Supported MP3 players do not currently run under Windows NT or Windows 2000/XP. You must 
be running SIREN XPress on Windows 9x to upload songs to portable players.  
SIREN XPress includes 20 free MP3 encodes, with unlimited MP3 playback.  
 
SIREN XPress makes it easy to organize your music: 
• SIREN XPress includes a powerful, database-driven music management engine. 
• The Sort, Group, and Filter tools provide you with superior control over your music library. 
• Use the Field Chooser window to view your collection the way you want to see it. 
 
SIREN XPress brings powerful functionality to your desktop: 
• Use Search for Music to find music on a network or removable drive. 
• Export custom playlists to your Rio or Nomad II portable MP3 device. 
• Use your Microsoft Internet Keyboard hotkeys to control SIREN XPress's functions. 
 

Siren™ XPress Quick Start 
Welcome to Sonic Foundry’s Siren XPress! This guide is designed to provide you with information that will 
allow you to immediately begin taking advantage of the powerful features of Siren™ XPress. 

Siren XPress allows you to operate in Philips compact mode or normal mode. The compact mode includes only 
the Transport buttons (Play, Stop, Pause, etc.). The normal mode displays the entire Siren XPress window, and 
allows access to all Siren XPress functionality. You can toggle between the Philips compact mode and normal 
mode using any of the following methods: 

• Click the Compact/Skin Mode button. 
• Choose the Compact/Skin Mode option from the View menu. 
• Press Ctrl + M on your keyboard. 
 
You can expand the Philips compact mode to display the current and next songs, the Compact/Skin Mode 
button, and the Select Playlist button. To expand the compact mode, click the Expand control on the right 
end of the player. You can also use this control to collapse the compact mode. The Siren XPress expanded 
compact mode is shown below: 
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Music Files 
A music file refers to any audio file that Siren will play from your computer. Siren supports the following music 
file formats: *.wav, *.mp3, *.wma. 
 
Finding Music 
After you install Siren XPress, a configuration wizard will scan your local hard drives for any *.mp3, *.wma, and 
*.wav files, and add them to your Siren XPress music library.  If you are unable to play music or use the 
transport controls for Siren XPress after the installation process, you can manually run the Configuration 
Wizard from Siren’s normal mode by choosing Configuration Wizard from the Options menu.  
 
You can also search your hard drive(s) for music to add to your music library any time by choosing Search 
Computer for Music from the Options menu. 
 

Playing Music 
Siren will allow you to play *.mp3, *.wma, and *.wav files, as well as audio CDs.  You can start playing music 
immediately by clicking on the Play button in either compact or normal mode.   

Playing music by type 
With the compact mode expanded, click on the Select Playlist button. From the menu that displays, you can 
select your music by Album, Artist, Genre, or Playlist, or choose to play an Audio CD. 
 
Transport Controls 
All of the transport controls (Play, Pause, Next Song . . . ) effect music file playback, unless there is a music 
CD in the PC’s CD/DVD drive or Audio CD is selected using the Select Playlist button.  In these cases clicking 
Play will start CD playback.  To re-assign the Transport Controls to music file playback simply select My Music 
or My Playlists from the Select Play list button. 
 

Graphic Effects 
Siren XPress displays dazzling visual effects during audio playback.  Siren XPress defaults to random visual 
effects.  To choose a particular effects pattern, right-click on the visual display and choose from the list of 
available graphic effects. 
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Recording from a CD 
1. Place an audio CD in your computer’s CD-ROM drive. 
2. In normal mode, choose Play or Record Music CDs from the View menu. Your computer’s CD drives are 

displayed in the Explorer panel. 
3. In the drop-down list in the Explorer panel, specify the CD drive containing the audio CD. The CD’s tracks 

are displayed in the Explorer panel, and Siren attempts to access information for the CD. If the CD 
information does not appear, you can obtain the CD information by clicking the CDDB button, or you can 
add the information manually in the Explorer panel. If the CD information is not accessed or added 
manually, Siren records the songs as “Unknown” and numbers them sequentially. 

4. Select the song(s) to be recorded. 
5. From the File menu, choose Record to Library. Siren begins recording files to the folder specified in the 

Preferences dialog, and a meter in the Status panel depicts the progress of the recording. 
6. To halt recording at any time, choose Cancel Recording from the File menu. 
7. To monitor the recording progress, select Recording List from the Explorer panel drop-down list, or, if 

Tree View is enabled, double-click on the Recording List folder. 
 
Note: You can play music from the music library while you are recording CDs, but you cannot listen to the CD 
itself during recording. 

Additional Help 
For more detailed information about Siren XPress features, please refer to the online Help file accessible from 
Siren’s normal mode by clicking the Help menu and choosing Contents and Index.  
 
For additional information on other Sonic Foundry products, visit www.sonicfoundry.com. 

Upgrading to Siren Jukebox 
If you like Siren XPress, but want more powerful options, get these additional features when you upgrade to 
Sonic Foundry’s Siren Jukebox:  

• CD burning  

• Unlimited MP3 ripping  

• Advanced audio effects  

To upgrade, choose Instant Upgrade from the Help menu. 
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AUDIO PIX 
AudioPix™ makes it easy to combine digital images with MP3 sound to get the ultimate multimedia 
presentation.  In just three simple steps you will have an exciting new MPEG format that can be played back in 
either of the popular players, RealPlayer® or Windows Media™ Player.  Now for the first time, you don’t have 
to be a Web Master to create your own unique presentations – just grab an MP3 file, some of your most 
treasured images and let your imagination go. 
 
• Turn your wedding photos and special occasions into a creative slideshow for friends and family 
 
• Keep your vacation memories alive forever.  Go on vacation without going on vacation! 
 
• Create an “Internet Commercial” to promote your business 
 
To install AudioPix, follow these simple steps: 
 
1) Insert your install CD into your CD drive 
2) Go to D:\Applications\QSound Labs\AudioPix\ (D represents your CD-ROM drive) 
3) Double click on apixfree.exe 
4) Follow the on-screen instructions for installation.  The required serial number is located at 

D:\Applications\QSound Labs\AudioPix\.  Open the apixfree.txt file. 
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RECORDING SOURCE CONFIGURATION 
Philips Seismic Edge™ allows you to record sounds and music from various input sources (i.e. microphone, 
audio CD, line in, etc). Before you start recording, you need to configure the recording source as follow: 
 

• Open the Volume Mixer, go to Options, and select Properties. 
 

 
 

•  Choose Recording under “Adjust Volume for”, and check the recording source that you want to display 
in the Recording Mixer. 

 
• Click OK, and the Recording Mixer window will open. Now you can select the recording source you 

intend to use and adjust the recording volume level. 
• Open your favorite recording application and start recording. 
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RESOLVING I/O CONFLICTS 
Conflicts between your audio card and another device may occur if they are set to use the same I/O 
address.  To resolve I/O conflicts, change the resource settings of your Philips Seismic Edge card or 
the conflicting device using Device Manager in Windows® 95/98. 

 
If you are still unable to determine which card is causing the conflict, remove all cards except the Philips 
Seismic Edge card and other essential cards (for example, disk controller and graphics cards).  Add 
each card back until Device Manager indicates that a conflict has occurred. 

 
To resolve conflicts in Windows®  95/98 
 

1. Click the Start button, point to Settings, and then click Control Panel. 
2. In the Control Panel window, double-click the System icon. 
3. In the System Properties dialog, click the Device manager tab. 
4. Under the Sound, Video and Game Controllers entry, select the conflicting audio card driver, 

indicated by an exclamation mark (!), and click the Properties button. 
5. In the Properties dialog, click the Resources tab. 
6. Select Use Automatic Settings and click the OK button. 
7. Restart your computer to allow Windows 95/98 to reassign resources to the devices. 
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UNINSTALLING SOFTWARE DRIVERS 
 
Windows 95/98 Uninstall 
 
1. Select Control Panel, Add/Remove Programs and select Philips Seismic Edge Audio Support Files.  

Click the Add/Remove button.  
  
2. You will be prompted to shutdown your computer after uninstall for the changes to take effect.  Click 

Yes to shutdown your computer and then remove Philips Seismic EdgeTM from your system. 
 

Windows NT Uninstall 
Browse to the Multimedia page in the Control Panel, click on the “Devices” tab, under “Audio Devices” 
select “Philips Seismic Edge  Audio”, and then click the “Remove” button. Shutdown your computer and 
remove Philips Seismic Edge™ from your system. 
 

Windows 2000 and Windows XP Uninstall 
1. Open the Add/Remove Hardware control panel applet 
2. Select “Uninstall/Unplug a Device”.  Click Next. 
3. Select “Uninstall a Device”.  Click Next. 
4. Choose Philips Seismic Edge Audio from the list.  Click Next. 
5. Click Yes on confirm screen.  Click Next. 
6. Open the Add/Remove Hardware control panel applet 
7. Select “Uninstall/Unplug a Device”.  Click Next. 
8. Select “Uninstall a Device”.  Click Next. 
9. Choose Philips Seismic Edge Game Port Enumerator from the list. Click Next. 
10. Click Yes on the confirm screen.  Click Next. 
11. Open the Add/ Remove Hardware control panel applet 
12. Select “Uninstall/Unplug a Device”.  Click Next. 
13. Select “Uninstall a Device”.  Click Next. 
14. Choose Philips Seismic Edge Support Registers from the list. Click Next. 
15. Click Yes on the confirm screen.  Click Next. 
16. Open the Add / Remove Programs control panel applet 
17. Click on Philips Seismic Support Files.  Click Change/Remove. 
18.  Power down your computer and remove your sound card. 
 


